Extron Certified DSP Bundle for Microsoft Teams Rooms - Extra Large Room
Microsoft Teams Rooms Certified Design Solution
Safety Instructions

WARNING: This symbol, ⚠, when used on the product, is intended to alert the user of the presence of uninsulated dangerous voltage within the product's enclosure that may present a risk of electric shock.

ATTENTION: This symbol, ⚠, when used on the product, is intended to alert the user of important operating and maintenance (servicing) instructions in the literature provided with the equipment.


Instructions de sécurité • Français

AVERTISSEMENT : Ce pictogramme, ⚠, lorsqu'il est utilisé sur le produit, signale à l'utilisateur la présence à l'intérieur du boîtier du produit d'une tension électrique dangereuse susceptible de provoquer un choc électrique.

ATTENTION : Ce pictogramme, ⚠, lorsqu'il est utilisé sur le produit, signale à l'utilisateur des instructions d'utilisation ou de maintenance importantes qui se trouvent dans la documentation fournie avec l'équipement.

Pour en savoir plus sur les règles de sécurité, la conformité à la réglementation, la compatibilité EMI/EMF, l'accessibilité, et autres sujets connexes, lisez les informations de sécurité et de conformité Extron, réf. 68-290-01, sur le site Extron, www.extron.com.

Istruzioni di sicurezza • Italiano

AVVERTENZA: Il simbolo, ⚠, se usato sul prodotto, serve ad avvertire l'utente della presenza di tensione non isolata pericolosa all'interno del contenitore del prodotto che può costituire un rischio di scosse elettriche.

ATTENTZIONE: Il simbolo, ⚠, se usato sul prodotto, serve ad avvertire l'utente della presenza di importanti istruzioni di funzionamento e manutenzione nella documentazione fornita con l'apparecchio.


Instrucciones de seguridad • Español

ADVERTENCIA: Este símbolo, ⚠, cuando se utiliza en el producto, avisa al usuario de la presencia de voltaje peligroso sin aislar dentro del producto, lo que puede representar un riesgo de descarga eléctrica.

ATENCIÓN: Este símbolo, ⚠, cuando se utiliza en el producto, avisa al usuario de la presencia de importantes instrucciones de uso y mantenimiento estas están incluidas en la documentación proporcionada con el equipo.


Инструкция по технике безопасности • Русский

ПРЕДУПРЕЖДЕНИЕ: Данный символ, ⚠, если указан на продукте, предупреждает пользователя о наличии неизолированного опасного напряжения внутри корпуса продукта, которое может привести к поражению электрическим током.

ВНИМАНИЕ: Данный символ, ⚠, если указан на продукте, предупреждает пользователя о наличии важных инструкций по эксплуатации и обслуживанию в руководстве, прилагаемом к данному оборудованию.

Для получения информации о правилах техники безопасности, соблюдении нормативных требований, электромагнитной совместимости (ЭМП/ЭЭС), возможностях доступа и других вопросах см. руководство по безопасности и соблюдению нормативных требований Extron на сайте Extron: www.extron.com, номер по каталогу - 68-290-01.
**Safety Notice - Simplified Chinese**

**Warning:** This symbol on the product indicates that there is an ungrounded hazardous voltage inside the enclosure, which may result in electrical shock.

**Notice:** This symbol on the product indicates that the user should refer to the main operating and maintenance (repair) instructions in the equipment's accompanying manual.

For more information on the product’s safety guidelines, compliance with regulations, EMI/EMF compatibility, accessibility, and related topics, please visit the Extron website, www.extron.com, and refer to the Extron Safety and Regulatory Compliance Guide (P/N 68-290-01).

---

**안전 지침 - 繁體中文**

**警告:** 若产品上使用此符号，是为了提醒使用者，产品机壳内存在未隔離的危险电压，可能会导致触电之风险。

**注意:** 若产品上使用此符号，是为了提醒使用者，设备随附的用户手册中有重要的操作和维护（维修）说明。

有关安全性指导方针、法規遵守、EMI/EMF相容性、存取範圍和相關主題的詳細資訊，請瀏覽 Extron 網站: www.extron.com，然後參閱 《Extron 安全性與法規遵守手冊》，準則編號 68-290-01。

---

**안전 지침 - 한국어**

**경고:** 이 기호가 제품에 사용될 경우, 제품의 인클로저 내에 있는 접지되지 않은 위험한 전류로 인해 사용자가 감전될 위험이 있습니다.

**주의:** 이 기호가 제품에 사용될 경우, 장비와 함께 제공된 책자에 나와 있는 주요 운영 및 유지보수(정비)의 지침을 참조해 주십시오.


---

**Copyright © 2022 Extron. All rights reserved. www.extron.com**

**Trademarks**

All trademarks mentioned in this guide are the properties of their respective owners.

The following registered trademarks (®), registered service marks (™), and trademarks (™) are the property of RGB Systems, Inc. or Extron (see the current list of trademarks on the Terms of Use page at www.extron.com):

<table>
<thead>
<tr>
<th>Registered Trademarks (®)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extron, Cable Cubby, ControlScript, CrossPoint, DTP, eBUS, EDID Manager, EDID Minder, eLink, Flat Field, FlexOS, Glitch Free, Global Configurator, Global Spatializer, GlobalViewer, Hideaway, HyperLane, IP Intercom, IP Link, Key Minder, LinkLicense, LockIt, MediaLink, MediaPort, NAV, NetPA, PlenumVault, PoleVault, PowerCage, PURE3, Quantum, ShareLink, Show Me, SoundField, SpeedMount, SpeedSwitch, StudioStation, System INTEGRATOR, TeamWork, TouchLink, V-Lock, VN-Matrix, VoiceLift, WallVault, WindoWall, XPA, XTP, XTP Systems, and ZipClip</td>
</tr>
</tbody>
</table>

| Registered Service Mark (®) | S3 Service Support Solutions |

<table>
<thead>
<tr>
<th>Trademarks (™)</th>
</tr>
</thead>
<tbody>
<tr>
<td>AAP, AFL (Accu-RATE Frame Lock), ADSP (Advanced Digital Signal Processing), AVEdge, CableCover, CDRS (Class D Ripple Suppression), Codec Connect, DDSP (Digital Display Sync Processing), DMI (Dynamic Motion Interpolation), Driver Configurator, DSP Configurator, DSVP (Digital Sync Validation Processing), EIP, Everlast, FastBite, Flex35, FOX, FOXBOX, IP Intercom HelpDesk, MAAP, MicroDigital, Opti-Torque, PendantConnect, ProDSP, QS-FPC (QuickSwitch Front Panel Controller), Room Agent, Scope-Trigger, SIS, Simple Instruction Set, Skew-Free, SpeedNav, Triple-Action Switching, True4K, True8K, Vector™ 3K, WebShare, XTRA, and ZipCaddy</td>
</tr>
</tbody>
</table>
NOTE: This device complies with part 15 of the FCC rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) This device must accept any interference received, including interference that may cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC rules. These limits provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. There is no guarantee that interference will not occur. If this equipment does cause interference to radio or television reception, which can be determined by turning the equipment off and on, you are encouraged to try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

In order to maintain compliance with FCC regulations, shielded cables must be used with this equipment. Operation with non-approved equipment or unshielded cables is likely to result in interference to radio and TV reception. The user is cautioned that changes and modifications made to the equipment without the approval of the manufacturer could void the user’s authority to operate this equipment.

NOTE: For more information on safety guidelines, regulatory compliances, EMI/EMF compatibility, accessibility, and related topics see the Extron Safety and Regulatory Compliance Guide on the Extron website.
Conventions Used in this Guide

Notifications
The following notifications are used in this guide:

**DANGER:**
- Will result in serious injury or death.
- Entraînera des blessures graves ou la mort.

**ATTENTION:**
- Risk of property damage.
- Risque de dommages matériels.

**NOTE:** A note draws attention to important information.

Specifications Availability

Extron Glossary of Terms
## Contents

### Introduction ................................................................. 1
   About this Guide....................................................... 1
   Overview ................................................................. 1
   Requirements ............................................................ 1
   Application Diagrams.................................................. 2
   Installation Details.................................................... 3
   Speaker Installation................................................... 3

### Configuring Extron Certified DSP Bundle for Microsoft Teams Rooms - Extra Large Room ........................................ 4
   Configuration Overview............................................... 4
   Sennheiser TeamConnect Ceiling 2 Setup ....................... 4
   Sennheiser TeamConnect Ceiling 2................................. 4
   Dante Controller Setup ............................................... 6
   Creating Subscriptions Between Sennheiser TCC2 and Extron DMP 128 Plus C V AT ........ 6
   Extron DMP 128 Plus C V AT Setup .............................. 10
   USB Naming............................................................... 12
   Edit Macros ............................................................... 13
   Microsoft Teams Rooms Setup..................................... 15

### Advanced Settings and Troubleshooting .............................. 17
   DMP Plus Acoustic Echo Cancellation (AEC) ...................... 17
   AEC Setup Overview................................................... 17
   AEC Dialog ............................................................... 17
   Noise Cancellation...................................................... 19
   Advanced AEC Controls .............................................. 19
   Technical Support....................................................... 19
Introduction

This section provides an overview of the Extron Certified DSP Bundle for Microsoft Teams Rooms - Extra Large Room. Topics include:

- About this Guide
- Overview
- Requirements
- Application Diagrams

About this Guide

This guide describes the integration of the Extron Certified DSP Bundle for Microsoft® Teams Rooms - Extra Large Room system.

Overview

Microsoft and Extron have come together to provide Microsoft Teams Rooms solutions with our certified hardware. Now it is easier than ever to stay connected with flexibility of realtime collaboration from anywhere. The products in our Microsoft Teams Rooms Certified Design Solutions have been designed and meticulously tested for best in class performance and ease of use.

Requirements

<table>
<thead>
<tr>
<th>Product</th>
<th>Description</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>DMP 128 Plus C V AT</td>
<td>12x8 Digital Matrix Processor w/ AEC, VoIP, &amp; Dante</td>
<td>1</td>
</tr>
<tr>
<td>XPA U 1004 SB</td>
<td>Four-Channel Bridgeable Output Amplifier</td>
<td>1</td>
</tr>
<tr>
<td>SF 26CT LP</td>
<td>6.5” Two-Way Ceiling Speakers, 70/100V, Pair</td>
<td>3</td>
</tr>
<tr>
<td>SPK14P</td>
<td>14 AWG Plenum Speaker Cable - 150’(45.7 m)</td>
<td>1</td>
</tr>
<tr>
<td>USB CFG Cable</td>
<td>USB A Male to USB Mini B Male 6’ (1.8 m)</td>
<td>1</td>
</tr>
<tr>
<td>Audio Cable</td>
<td>Balanced audio cable for Audio DSP output to Amplifier Input - 6’ (1.8 m)</td>
<td>1</td>
</tr>
<tr>
<td>Network Cable</td>
<td>Cat-6 Plenum network cable - 50’ (15.2 m)</td>
<td>2</td>
</tr>
<tr>
<td>Network Cable</td>
<td>Cat-6 Plenum network cable - 35’ (10.7 m)</td>
<td>2</td>
</tr>
<tr>
<td>Network Cable</td>
<td>Cat-6 Non-Plenum network cable - 6’ (1.8 m)</td>
<td>1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Product</th>
<th>Description</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>TeamConnect Ceiling 2</td>
<td>Beamforming Ceiling Microphone array</td>
<td>2</td>
</tr>
<tr>
<td>SL CM EB US</td>
<td>Ceiling Mic Extension Brackets US</td>
<td>2</td>
</tr>
</tbody>
</table>
## Additional Required Equipment

<table>
<thead>
<tr>
<th>Product</th>
<th>Description</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>MTR Computer</td>
<td>Microsoft Teams Rooms Computer with Camera and Control interface</td>
<td>1</td>
</tr>
<tr>
<td>Network Switch</td>
<td>10-port PoE network switch</td>
<td>1</td>
</tr>
<tr>
<td>Windows computer or laptop</td>
<td>Computer MUST contain the following:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Extron DSP Configurator</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>• Dante Controller</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Sennheiser TCC2 Control Cockpit</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Extron DSP Configuration *.zip files</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE:** The Windows® computer or laptop is required for adjustments and can be disconnected after system configuration.

### Application Diagrams

The following illustrations are examples of configuring the DMP 128 Plus C V AT for use with Teams in a conference room.

**Figure 1.** Conference Room Application Example
**NOTE:** The supplied network switch is manageable, however the default configuration is sufficient for this solution to function.

### Installation Details

See figure 3 for the connections needed between the DMP Plus and the XPA U amplifier. Use the supplied balanced audio cable to connect each product.

![Captive Screw Audio Cable Wiring](image1)

**Figure 3. Captive Screw Audio Cable Wiring**

### Speaker Installation

During installation of the speaker(s), please ensure the rotary tap selector switch is set to 70V, 16W.

For detailed setup instructions please refer to the SF 26CT LP setup guide.
Configuring Extron Certified DSP Bundle for Microsoft Teams Rooms - Extra Large Room

This section provides information on the following topics:

- Configuration Overview
- Sennheiser TeamConnect Ceiling 2 Setup
- Dante Controller Setup
- Extron DMP 128 Plus C V AT Setup
- Microsoft Teams Rooms Setup

Configuration Overview

1. Unbox and connect the provided hardware using the diagram in figure 2 on page 3.

   **NOTE:** Do not connect the USB cable between the Microsoft Teams Rooms (MTR) computer and Extron DMP Plus. This is connected after the Extron DMP Plus is properly configured.

2. Configure a computer with the following software utilities:
   - Extron DSP Configurator Software
   - Dante Controller Software
   - Sennheiser Control Cockpit Software

3. Download the following from the Extron website (www.extron.com/microsoft):
   - Extron Certified DSP Extra Large Room Bundle .zip folder

Sennheiser TeamConnect Ceiling 2 Setup

**Sennheiser TeamConnect Ceiling 2**

Sennheiser TeamConnect 2 (TCC2) audio output is connected to the Extron DMP Plus series via the Dante audio connection.

An additional PoE/Control connection is required to support LED feedback, microphone mute controls as well as powering the ceiling microphone. **Figure 4** on page 5 shows the browser-based Control Cockpit interface used to detect and identify the TCC2.

The browser-based Control Cockpit interface detects and identifies the TCC2 using mDNS when the network cable is attached to the TCC2 Ethernet PoE/Ctrl port.
Figure 4. Control Cockpit Interface

From this interface, the following actions are performed:

- Setting Network Settings
- Beam-steering and Exclusion Zone adjustments

Setting Network Settings

Set and document the address and host name of the device. This is required later.

Figure 5. Control Cockpit Network Interface

Beam-steering and Exclusion Zone Adjustments (Optional)

If additional settings are required to reduce background noise of items such as HVAC, projector fans, credenzas, etc., the TCC2 has a Priority Zone and up to 5 Exclusions Zones which can be leveraged to remove these from the microphone pickup.

To configure a zone:

1. Select the desired unit from the Device List, a Properties dialog box is opened.
2. Under the Zones tab, the 3D Overall View shows the real-time focus of the TCC2 automatic beam-steering (see figure 6 on page 6). Users can manually enable a Priority or Exclusion Zone.
3. Edit the vertical and horizontal angles of the selected exclusion zones (see figure 7 on page 6) to remove the observed noise.

NOTE: Refer to the TeamConnect Ceiling 2 instruction manual for more information.
Dante Controller Setup

Dante Controller from Audinate is required to route transmitters and receivers, and can be used to configure Dante settings and monitor performance.

Creating Subscriptions Between Sennheiser TCC2 and Extron DMP 128 Plus C V AT

1. Ensure the Laptop, DMP 128 Plus C V AT (Dante), and TCC2 (Dante) are connected to the same network.

2. From the Windows Start Menu select: All Programs > Audinate > Dante Controller. The Dante Controller - Network View screen opens. Dante Controller auto-discovers Dante devices on the network and advertises itself to allow other Dante-enabled devices to communicate with it. Transmitters connect to receivers using the subscription matrix (see figure 8 on page 6).

**NOTE:** The DMP 128 Plus C V AT and TCC2 Dante connections are set to DHCP by default. If they cannot be discovered, ensure the correct interface is selected on the PC by selecting Interfaces from the File menu.
3. Open the **Device View** of the DMP 128 Plus C V AT by double clicking it in the **Routing** tab.

4. In the **Receive** tab, rename the first two receive channels to TCC2-A and TCC2-B.

![Figure 9. Receive Tab of Network View Screen](image)

5. In the **Transmit** tab, rename the ninth transmit channel to TCC2 Ref.

![Figure 10. Transmit Tab of Network View Screen](image)

6. In the **Device Config** tab, rename the DMP 128 Plus C V AT to the desired name and click **Apply**.

![Figure 11. Device Config Tab of Network View Screen](image)
7. From the Device View pulldown, choose the **TCC2**.

8. In the **Device Config** tab, rename the **TCC2** microphones to **TCC2-A** and **TCC2-B**.

![Device View](image)

**Figure 12. Renaming the Device**

9. Close the **Device View** window and return to the **Network View** window.

10. To show the transmitters of a Dante device, click the + box next to the desired device in the **Dante Transmitters** panel, such as **TCC2-A** (see figure 13). The + changes to a - sign when the device expands.

11. To show the receivers of a Dante device, click the + box next to the desired device in the **Dante Receivers** panel, such as **DMP128PlusCVAT**.

12. Click the intersections of the desired subscriptions between transmitter and receiver channels.
Figure 13. Network View Screen

NOTES:

- The FarEndOut transmitter channels of the TCC2 device should be routed to the first two receiver channels of the DMP 128 Plus C V AT. A check mark at the intersection indicates the subscription is made. A check mark also appears next to the receive channel.
- The TCC2 Ref transmitter channel of the DMP 128 Plus C V AT should be routed to the AEC Ref receiver channel of each TCC2.
Extron DMP 128 Plus C V AT Setup

To configure the Extron DMP 128 Plus C V AT, perform these steps:

1. Set IP address via embedded web page.
2. Set the computer or laptop IP address within the range of the product IP address. The default settings are (LAN for non-V-models, LAN 1 for V-models):
   - IP Address: 192.168.254.254
   - Subnet: 255.255.255.0
   - Gateway: 0.0.0.0
3. From a web browser, enter the device IP address into the address field.

   **NOTE:** If the local system administrators have not changed the IP address, and the device has not been assigned an IP address via DHCP, the default address (LAN for non-V-models, LAN 1 for V-models) is 192.168.254.254.

4. Press Enter.
5. On the login page, enter “admin” as the Username, enter the Password (if one has been set), and click Sign In.
   - By default, the password is the product serial number
   - If mode 5 reset has been performed, then the password is clear and the Password field can be left blank.

   **Figure 14.** Login Page

6. The Communications Settings panel displays TCP/IP communication settings. Click Edit to open the Communication Settings dialog box and edit the TCP/IP settings.

   The following can be edited: DHCP status, IP address, subnet mask, and default gateway. This dialog box also displays the device MAC address. To revert the computers IP address to a range which can communicate to the new IP address schema.

   **NOTE:** If Use DHCP is enabled, IP address, subnet mask, and default gateway cannot be edited.
To push the DSP Template file to the DMP Plus:

1. Open the Extron DSP Template file (downloaded previously in .zip file) with DSP Configurator software.

2. Connect to a DMP 128 Plus C V AT in Live Mode by clicking the Live button in the menu bar of DSP Configurator (see figure 16, 1). Alternatively, select Tools > Connect to Device or press F6 on the keyboard. The Connect to Device dialog box opens.

3. Click the TCP/IP tab in the dialog box.

4. Enter the IP address of the device in the Hostname or IP Address field. If necessary, enter the device password in the Password field.

5. When a connection type with a device is established, the Synchronize with Device dialog box opens. Select Push.
6. Click **OK**.

Once the push is completed, the current state of the connected DMP 128 Plus C V AT is displayed in the **DSP Configurator** status panel and the device is ready for further configuration.

### USB Naming

The **USB Audio** tab allows for customizing USB audio interface names and terminal types (see **Figure 18** on page 13). To configure **USB Audio** settings in **DSP Configurator**:

**NOTE:** Extron recommends configuring these settings before connecting USB audio devices to a PC.

1. From the **Tools** menu, select **Device Settings**. The Device Settings dialog box opens.
2. Click the **USB Audio** tab.
3. In the **USB Name** field, enter the desired name for the USB Audio interface.
4. In the **USB Terminal Type** panel, choose **Echo Cancelling Speakerphone**.
5. Click **Apply** to activate the new settings.
6. Connect the USB Audio port to the PC.
Edit Macros

Macros are sets of actions that can affect the local DMP 128 Plus C V AT and other Extron products on the same TCP/IP network. Macros are required for the Mute Sync Status indicators on the Sennheiser microphone to function properly. They can be configured in Emulate or Live mode via an Ethernet connection only, and they can be saved to a configuration file or pushed to DMP 128 Plus C V AT internal memory. Macros are comprised of up to 32 actions that occur in sequence to quickly configure a system for specific applications.

Figure 18. USB Audio Tab

Figure 19. Configure Macros Screen

1. Select 7 Add/Edit Remote Destinations.
2. Select TCC2-A and update the IP address to match the microphone that was configured earlier.
3. Select **Apply**.

4. Select **Push Macros to Device**.

![Add/Edit Macro Destinations Dialog Box](image)

**Figure 20.** Add/Edit Macro Destinations Dialog Box
Microsoft Teams Rooms Setup

The Extron DMP 128 Plus C V AT connects to the Microsoft Teams Rooms system from the USB Audio port.

Once the previous steps outlined in this document have been complete, please connect the Microsoft Teams Rooms system to the DMP 128 Plus C V AT USB Audio connection via the provided USB mini-B cable.

The following steps detail the required settings on the Microsoft Teams Rooms device:

1. Select More in the Teams Rooms interface.

![Microsoft Teams Rooms Interface Screen](image1)

**Figure 21.** Microsoft Teams Rooms Interface Screen

2. Select Settings.

![Microsoft Teams Rooms Settings](image2)

**Figure 22.** Microsoft Teams Rooms Settings
3. In the **Settings** menu, select **Peripherals**, and use the dropdown lists to select the Extron DMP Plus (or configured **USB Name** in above steps) for each of the three parameters: Microphone for Conferencing, Speaker for Conferencing, and Default Speaker.

![Figure 23. Microsoft Teams Rooms Peripherals Dialog Box](image)

4. When you are finished, click **Save** and exit to return to the user interface.

**NOTE:** When using the Extron DMP 128 Plus C V AT, MTR disables its internal acoustic echo cancellation (AEC) audio processing so that all audio processing is completed through the external DSP—the Extron DMP 128 Plus C V AT. This provides the best audio performance.
Advanced Settings and Troubleshooting

This section provides the following topics:

- DMP Plus Acoustic Echo Cancellation (AEC)
- Technical Support

DMP Plus Acoustic Echo Cancellation (AEC)

AEC Setup Overview

Proper gain structure involves the relationship between the signal at the selected reference and the signal at the mic input, within the context of proper levels for the reference and mic inputs independently. The mic input gain setting is naturally optimized for the voice level of the talker in that room. Therefore, the amount of signal from the far end that is picked up by the mic is dependent on how much that far end signal is being amplified in the near end room and the distance from the mic to the speakers.

The reference signal is the signal received from the far end, which arrives at the USB-assigned Aux Inputs of the DMP Plus. This is sent to the sound reinforcement system within the near end room, as well as a designated output channel to set the reference level for the DMP Plus AEC processor.

AEC Dialog

The AEC dialog contains meters and indicator LEDs that are essential for setting up gain structure and monitoring activity.
Figure 24. AEC Controls

**AEC Indicators**
- **Far** – Lights when activity is detected from the remote site.
- **Near** – Lights when activity is detected from the local site.
- **Update** – Lights when the AEC is updating, for example, converging or reconverging.

**Meters**
- **ERL** – The ratio in dB between the signal at the reference and the signal at the AEC channel input. When ERL is a positive number, the signal level at the AEC channel input is lower than the signal at the selected reference.

**NOTE:** The ideal level range for these meter is 0 to +15 dB. This ensures the right amount of reference signal is being sent through the AEC processor.

- **ERLE** – The amount in dB of potential echo signal that the AEC algorithm, not including NLP processing, is cancelling.
- **TER** – The sum of ERL + ERLE, in dB.

**Select Reference**
The provided configuration includes a selected AEC reference. If necessary, a different AEC reference can be selected from the drop-down list.
**Noise Cancellation**

Noise Cancellation may be switched on or off from the AEC dialog. The noise canceller detects steady state noise, such as HVAC or other continuous system noise, and effectively removes it without causing audible artifacts.

**Advanced AEC Controls**

Click on the open/collapse icon to expose the advanced AEC controls.

Advanced control functionality is as follows:

**Non-linear processing (NLP) controls**

- **Enable NLP** – This box is checked by default. Non-linear processing is necessary for the complete removal of echo.
- **NLP Presets** – Click a button to load a set of values to the three NLP parameters.
- **Max NLP Reduction** – The maximum possible reduction in echo artifacts that can be applied.
- **Attack Time** – The speed in which NLP is applied.
- **Release Time** – The speed in which NLP is released.

**Additional controls**

- **Double Talk Echo Reduction** – Sets the amount of echo reduction applied during double-talk.
- **Comfort Noise** – Sets a comfort noise level in dB to eliminate states of complete silence, which may be perceived as a failed connection.

**Technical Support**

For Extron technical support, visit: [https://www.extron.com/company/contactus.aspx](https://www.extron.com/company/contactus.aspx)

For Sennheiser technical support, visit: [https://sennheiser.com/service-support](https://sennheiser.com/service-support)
Extron Warranty

Extron warrants this product against defects in materials and workmanship for a period of three years from the date of purchase. In the event of malfunction during the warranty period attributable directly to faulty workmanship and/or materials, Extron will, at its option, repair or replace said products or components, to whatever extent it shall deem necessary to restore said product to proper operating condition, provided that it is returned within the warranty period, with proof of purchase and description of malfunction to:

**USA, Canada, South America, and Central America:**
Extron
1230 South Lewis Street
Anaheim, CA 92805
U.S.A.

**Europe:**
Extron Europe
Hanzeboulevard 10
3825 PH Amersfoort
The Netherlands

**China:**
Extron China
686 Ronghua Road
Songjiang District
Shanghai 201611
China

**Asia:**
Extron Asia Pte Ltd
135 Joo Seng Road, #04-01
PM Industrial Bldg.
Singapore 368363
Singapore

**Japan:**
Extron Japan
Kyodo Building, 16 Ichibancho
Chiyoda-ku, Tokyo 102-0082
Japan

**Africa:**
Extron South Africa
3rd Floor, South Tower
160 Jan Smuts Avenue
Rosebank 2196, South Africa

This Limited Warranty does not apply if the fault has been caused by misuse, improper handling care, electrical or mechanical abuse, abnormal operating conditions, or if modifications were made to the product that were not authorized by Extron.

**NOTE:** If a product is defective, please call Extron and ask for an Application Engineer to receive an RA (Return Authorization) number. This will begin the repair process.

<table>
<thead>
<tr>
<th>Region</th>
<th>USA</th>
<th>Asia</th>
<th>Japan</th>
<th>Middle East</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>714.491.1500 or 800.633.9876</td>
<td>65.6383.4400</td>
<td>81.3.3511.7655</td>
<td>971.4.299.1800</td>
</tr>
<tr>
<td>Europe</td>
<td>31.33.453.4040 or 800.3987.6673</td>
<td>31.33.453.4040 or 800.3987.6673</td>
<td>81.3.3511.7655</td>
<td>971.4.299.1800</td>
</tr>
<tr>
<td>Africa</td>
<td>27.11.447.6162</td>
<td>65.6383.4400</td>
<td>81.3.3511.7655</td>
<td>971.4.299.1800</td>
</tr>
</tbody>
</table>

Units must be returned insured, with shipping charges prepaid. If not insured, you assume the risk of loss or damage during shipment. Returned units must include the serial number and a description of the problem, as well as the name of the person to contact in case there are any questions.

Extron makes no further warranties either expressed or implied with respect to the product and its quality, performance, merchantability, or fitness for any particular use. In no event will Extron be liable for direct, indirect, or consequential damages resulting from any defect in this product even if Extron has been advised of such damage.

Please note that laws vary from state to state and country to country, and that some provisions of this warranty may not apply to you.